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Warranty 

Pyramid Solutions warrants solely to the initial end-user buyer of this product that this 
product will, for one year after shipment by Pyramid Solutions (the "Warranty Period"), 
conform to Pyramid Solutions' written specifications for this product. 
 
Pyramid Solutions' sole and exclusive obligation, and Buyer's sole remedy for failure of this 
product to conform to the above warranty, is, at the option of Pyramid Solutions, that 
Pyramid Solutions will repair or replace this product or refund the monies paid for this 
product. The purchaser must notify Pyramid Solutions of any nonconformity during the 
Warranty Period. In the case of replacement of a non-conforming product, the Warranty 
Period will be tolled beginning on the date upon which Pyramid Solutions receives the non-
conforming product and will begin to run again when the purchaser of this product receives 
the repaired or replacement product. 
 
The warranty will not apply if this product: (1) fails, malfunctions, or is damaged as a result 
of handling, installation, maintenance, removal, modification or repair other than as 
specified in Pyramid Solutions' then-current user manual or similar documentation; (2) 
suffers a casualty or is subjected to abuse (including electrostatic discharge) or improper 
use; (3) is altered or damaged so that Pyramid Solutions is unable to verify the defect with 
its normal test equipment; or (4) is not returned in the same or equivalent container in 
which it was shipped. 
 
EXCEPT AS EXPRESSLY WARRANTED ABOVE, THIS PRODUCT IS SUPPLIED "AS IS" AND WITH ALL 
FAULTS. PYRAMID SOLUTIONS MAKES NO OTHER REPRESENTATIONS OR WARRANTIES, WHETHER 
EXPRESS OR IMPLIED, WITH RESPECT TO THIS PRODUCT AND PYRAMID SOLUTIONS EXPRESSLY 
DISCLAIMS ALL WARRANTIES AS TO ITS QUALITY, PERFORMANCE, MERCHANTABILITY, NON-
INFRINGEMENT, OR FITNESS FOR A PURPOSE. 
 
THE PURCHASER'S REMEDIES ARE EXPRESSLY LIMITED TO THE EXCLUSIVE REME- DIES STATED 
ABOVE. NEITHER PYRAMID SOLUTIONS NOR ANY DIRECT OR INDI- RECT SUPPLIER TO PYRAMID 
SOLUTIONS WILL BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL, SPECIAL, PUNITIVE, OR 
INDIRECT DAMAGES (INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFITS) ARISING 
OUT OF, RELATED TO, OR CAUSED, DIRECTLY OR INDIRECTLY BY, THE USE OR TRANSFER OF THIS 
PROD- UCT BY THE PURCHASER OF THIS PRODUCT OR ANY CUSTOMER OR SUCCESSOR HOLDER OF 
THIS PRODUCT, BY THE PERFORMANCE OR FAILURE TO PERFORM OF PYRAMID SOLUTIONS OR ANY 
DIRECT OR INDIRECT SUPPLIER TO PYRAMID SOLU- TIONS, OR IN ANY OTHER RESPECT, BY ANY 
OTHER ACT OR OMISSION OF PYRA- MID SOLUTIONS OR ANY DIRECT OR INDIRECT SUPPLIER TO 
PYRAMID SOLUTIONS, OR BY ANY OTHER CAUSE. IN NO EVENT WILL PYRAMID SOLUTIONS' OR ITS 
SUPPLIERS' TOTAL LIABILITY TO ANY PERSON FOR ANY CLAIM EXCEED THE SUM PAID TO PYRAMID 
SOLUTIONS FOR THE PRODUCT(S) GIVING RISE TO THE LIABILITY. 
 
THESE LIMITATIONS APPLY REGARDLESS OF WHETHER PYRAMID SOLUTIONS OR ITS SUPPLIER(S) IS 
(ARE) OR WAS (WERE) AWARE OF THE POSSIBILITY OF ANY DAMAGES AND REGARDLESS OF 
WHETHER ANY LIMITATION CAUSES A REMEDY TO FAIL OF ITS ESSENTIAL PURPOSE. 
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Preface 

Important User Information 

The data and illustrations found in this document are not binding. We reserve the right to 
modify our products in line with our policy of product development. The information in 
this document is subject to change and should not be considered as a commitment by 
Pyramid Solutions. Pyramid Solutions assumes no responsibility for errors that may appear 
in this document 
 
There are many applications of the BridgeWay module. Those responsible for the use of this 
device must satisfy themselves that all necessary steps have been taken to verify an 
application meets all performance and safety requirements including any applicable laws, 
regulations, codes, and standards. 
 
The illustrations and samples in this guide are intended solely for the purpose of example. 
Pyramid Solutions does not assume responsibility or liability for actual use based upon the 
examples shown in this publication. 
 
See the Installation and Operation Requirements section for important safety and 
installation details. 

 

Related Documentation 

Document Name Author Web Page 

EtherNet/IPTM Specification ODVA www.odva.org 

DeviceNetTM Specification ODVA www.odva.org 

Modbus Application Protocol Specification Modbus Org www.modbus.org 

Modbus Messaging on TCP/IP 
Implementation Guide 

Modbus Org www.modbus.org 

Table 1. Related Documentation 

 

Licenses and Trademarks 

 
EtherNet/IP™ and DeviceNet™ are trademarks of ODVA. 
Modbus is a trademark of Modbus Organization. 
Microsoft and Windows are trademarks of Microsoft Corporation. 
 

http://www.odva.org/
http://www.odva.org/
http://www.modbus.org/
http://www.modbus.org/
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BridgeWay Module Description 

Overview 

The Ethernet-DeviceNet BridgeWay enables connection of Information or Control level 
networks with your Device level network.   The BridgeWay provides full DeviceNet Master 
functionality with connectivity to up to 63 DeviceNet slave devices.  Data from DeviceNet 
slave devices is mapped to I/O Table locations, making it accessible to be read or written 
by the Ethernet controllers. The BridgeWay operates as an EtherNet/IP Adapter (server), 
allowing DeviceNet slave data to be transferred to and from an EtherNet/IP Scanner 
(client) device using I/O or explicit messages. The module also operates as a Modbus TCP 
slave (server), allowing DeviceNet slave data to be accessed as Modbus registers by a 
Modbus TCP master (client) controller. 
 
Examples of applications of the Ethernet-DeviceNet BridgeWay: 

 

• A gateway to connect information or control level networks to device level 
networks for programming, configuration, control, or data collection. (E.g. 
Modbus/TCP to DeviceNet) 

 

• BridgeWay can provide message router/bridge functionality from EtherNet/IP or 
Modbus TCP to DeviceNet. 
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Theory of Operation 

The BridgeWay appears as a single device on either network using standard protocol 
mechanisms. No special, or extended, protocol features are required of the devices on 
either network to read and write the data flowing through the I/O Table; all cross-network 
activity is transparent to the devices on either network. 
 

I/O Data to DeviceNet Slaves 

The BridgeWay provides centralized data storage, the I/O Table, for data that is shared 
between DeviceNet slave devices and Ethernet networks. Data is placed into the I/O Table 
by one network interface, allowing the data to be read by the other network interface. 
 

Input 
Buffer

Output 
Buffer

I/O Table

Read Inputs Input Data

Output DataWrite Outputs
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Figure 1. I/O Table Operation 

 

Explicit Message Bridging to DeviceNet 

The BridgeWay provides the message bridging from Ethernet to DeviceNet.   This is done 
through the Message Bridge which is has a CIP object interface and a set of Modbus 
register addresses.    
 

Message 
Bridge

Send Request Request

Get Response
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Response

 
Figure 2. Message Bridging Operation 
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DeviceNet Features 

• DeviceNet Master functionality supporting up to 63 DeviceNet slave devices. 

• Support for Explicit Messaging, Bit Strobe, Poll, Change of State (COS), and Cyclic 

slave connections 

• DeviceNet Slave functionality with configurable slave I/O size and connection 

support. 

• Baud rates of 125, 250, and 500 Kbps. 

• Configurable automatic baud rate detection option. 

• Automatic Address Recovery can be configured to replace a faulted slave device 

with a replacement device at the same MAC ID. 

• Configuration Recovery can be configured for slave devices so that a newly 

replaced slave can be configured to the same settings of the device it replaces. 

Combined with Automatic Address Recovery this feature is known as Automatic 

Device Recovery (ADR). 

• Transfers 496 bytes DeviceNet slave input data and 492 bytes DeviceNet slave 

output data. 

• Support for DeviceNet Quick Connect. 

• Configurable input safe state mode determines the state of slave input data when a 

slave’s I/O connection times out. 

• Optional Active Node List maintains a current list of the devices on the DeviceNet 

network for faster bridging functionality. 

• Automatic scan list generation can be used to quickly create default I/O 

connections to all DeviceNet slave devices on the network. 
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Ethernet Features 

1. Supports the EtherNet/IP protocol, Adapter Class with I/O Server, Message Server, 
and CIP Message Routing. 

 
2. Supports the Modbus TCP protocol with up to 4 simultaneous connections. 

Conforms to the Modbus TCP specification 1.0. 
 

3. Support for either static IP address or DHCP. 
 

4. Supports IP address conflict detection conforming to RFC 5227 and the ODVA 
EtherNet/IP specification. 

 
5. Network speed may be configured to 10Mbsps, 100Mbps or auto-negotiated.  

Duplex may be configured to half, full or auto-negotiated. 
 

6. EtherNet/IP and Modbus TCP may be supported simultaneously or either protocol 
may be disabled to meet system requirements. 

 
7. HTTP Web server provides information on the current status and configuration of 

the module.   
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System Requirements 

The following hardware and software components are needed to use the Ethernet-
DeviceNet BridgeWay. 
 

Required Hardware 

1. BridgeWay module. 
2. DeviceNet network and network power connection. 
3. Ethernet cabling. 
4. EtherNet/IP or Modbus TCP Controller or Client with access to the Ethernet 

network. 
5. 24 VDC power connection 
6. PC with USB port to execute BridgeWay Configuration Tool (BWConfig) and 

DeviceNet configuration tool (RSNetworx). 
7. Micro USB cable to connect PC running BWConfig to the BridgeWay. 

 

Optional Hardware 

1. DIN rail to mount the BridgeWay. 
 

Required Software 

1. BridgeWay Configuration Tool software (BWConfig) to configure the BridgeWay. 
2. DeviceNet configuration software such as RSNetworx for DeviceNet.  Note: 

RSNetworx v7.0 or later is required to support the full 128K of ADR configuration 
data; earlier versions support up to 64K.  

3. BWConfig requires that the PC be running Microsoft Windows 7 or higher. 
4. EDS file, BW4031.eds, downloadable from the Pyramid Solutions web site. 
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Installation 

Installation and Operation Requirements 

Power, input, and output (I/O) wiring must be in accordance with Class 1, Division 2 wiring 
methods - article 501-4(b) of the National Electric Code, NFPA 70 and in accordance with 
local codes. 
 
Field wiring terminal markings (wire type (Cu only, 14-30 AWG (0.2546-1.63mm)). 
 
Terminal tightening torque must be between 5-7 lb-in (0.5-0.8 Nm). 
 
For use in Class 2 circuits only. 
 

Suitable for surrounding temperature of 70 degrees C maximum, -25 degrees C minimum. 
 

Use 105 °C copper (Cu) wire only. 
 
Use Copper Conductors Only. 
 

 
Special conditions for safe use 
 
Use in Overvoltage Category I Pollution Degree 2 Environment conforming to EN 60664-
1. 
 
This equipment shall be installed in an enclosure that provides a degree of protection 
not less than IP54 in accordance with EN 60079-15. 
 
The enclosure must have a door or cover accessible only by the use of a tool. 
 
The equipment must be installed with a transient suppressor on the supply that does 
not exceed 140% (33.6 V DC) of the nominal rated supply voltage. 
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FAIL-SAFE OR CRITICAL OPERATIONS 
This product is not designed, intended, authorized, or warranted to be 
suitable for use or resale as control equipment in, or for other 
applications related to, hazardous or potentially-hazardous 
environments or applications requiring high-availability or fail- safe 
performance, such as in the operation of nuclear facilities, aircraft 
navigation or communications systems, air traffic control, life support, 
public works, weapons systems, or any other application in which the 
failure of a product could lead to property damage, death, personal 
injury, or environmental damage. 

 

 
EXPLOSION HAZARD 
Substitution of components may impair suitability for class 1, Division 2. 

 

 

EXPLOSION HAZARD 
When in hazardous locations turn off power before replacing or wiring 
modules.  

 

 

EXPLOSION HAZARD 
Do not disconnect equipment unless power has been switched off or the 
area is known to be nonhazardous.  
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Mounting 

The BridgeWay can be physically mounted onto a DIN rail or, if installed in areas exposed 
to vibration, on a wall for more stability. 
 

DIN Rail Mounting 

 

  
To mount the BridgeWay: 
Make sure the DIN rail locking tab on the back of the 
module is in the closed position, i.e. pushed all the way 
up. 
Hook the module on the DIN rail. (1) 
Push the module against the DIN rail to make it snap 
on. (2) 
 

 

 
To Unmount the BridgeWay: 
Use a screwdriver to pull the DIN rail locking tab on the 
back of the module to the open position, i.e. pulled all 
the way down. (1) 
Unhook the module from the DIN rail. (2) 
 

 

 
 
NOTE: Do not leave the module with the DIN rail 
locking tab in the open position.  This may eventually 
wear the mechanism out so that it cannot be used 
efficiently.  Be sure to push the locking tab back into 
the closed position after unmounting the module. 
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Wall Mounting 

The wall mount option may be used if the BridgeWay is to be placed in an environment 
exposed to vibration.  Wall mounting offers more stability than the traditional DIN rail 
mounting. 
 
NOTE: The Bridgeway should be mounted in a standing-up position to ensure constant air 
flow. 
NOTE: When the BridgeWay is wall mounted, the Ground connection must be made via 
the power connector. 
 

 

The wall mounting accessory package should 
contain: 

- Metal frame 
- Industrial Velcro 
- (4) plastic vibration dampers 

 

 

Remove the plastic adhesive protection from 
one side of the Velcro and attach the Velcro to 
the metal frame. 
 
Attach the four vibration dampers to the 
BridgeWay on the side that will face the wall. 
 

 

 
Remove the plastic adhesive protection from 
the other side of the Velcro. 
 

 

Turn the BridgeWay over so that the vibration 
dampers are facing down. 
 
Fasten the metal frame to the BridgeWay by 
pressing the frame firmly against the module to 
attach the Velcro to the BridgeWay. 
 

 

 
 
Attach the metal frame and the BridgeWay to 
the wall using screws and washers (not 
included). 
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Power and Network Connections 

The locations of the connectors are shown in the figure below. 
 

 
Figure 3. Connector Locations 

 

Connecting Power 

The BridgeWay requires 24 volts DC power on the 3-position terminal block connector on the 
top of the module. 

 
Figure 4. Power Connector 

 

Configuration USB Power 24VDC 

DeviceNet 

Ethernet 

Not Used 
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Connecting DeviceNet 

DeviceNet is connected to the 5-position terminal block connector on the bottom of the 
module. 

 
Figure 5. DeviceNet Connector 

The CAN High and Low signal lines should be connected to the CAN High and Low 
connections respectively on all devices on the network. The signal lines should not be 
swapped on any device connections. 
 

The BridgeWay module does not provide CAN network termination internally. Any 
termination required by the network (120 ohm) must be added during installation. 
 
See the DeviceNet Specification for specific rules on DeviceNet network connections and 
termination. 
 

Connecting to Ethernet 

The Ethernet connection uses a standard RJ45 connector.  The Ethernet socket is on the 
front of the module. 
 

Configuration Port Connector 

The Configuration Tool utilizes USB for communications with the BridgeWay.  A USB cable 
with a Micro-B connector is required to connect to the module.    The USB connector is 
located under the rubber flap on the front of the module; lift the flap for access to the 
connector. 
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Configuration 

This chapter describes how the Ethernet-DeviceNet BridgeWay is configured.   Configuration is 
done with a combination of the BridgeWay Configuration Tool (BWConfig) and a DeviceNet 
network configuration tool such as RSNetworx.  This chapter will discuss the details of both of 
the above configurations. 
 
The next chapter walks the reader through the steps to quickly configure the BridgeWay for a 
simple configuration. 
 

Starting BridgeWay Configuration Tool (BWConfig) 

The BridgeWay Configuration Tool allows you to configure the parameters associated with the 
Ethernet and DeviceNet network interfaces. 
 
BWConfig is a Microsoft Windows application that communicates with a BridgeWay over a USB 
connection. BWConfig is compatible with Microsoft Windows 7 and later. 
 

Installing the Tool 

Install BWConfig by running InstallBWConfig.exe which can be downloaded from the Pyramid 
Solutions web site. 
 

Connecting to the BridgeWay Module 

Connect the PC running BWConfig to the BridgeWay module using a standard USB-to-Micro-
USB cable between the PC USB port Micro-USB connector on the module.  It does not matter 
which PC USB port you use, BWConfig will scan each available port and detect the connection 
automatically. 
 

Starting the Tool 

Launch the BridgeWay Configuration Tool from the Pyramid Solutions → BWConfig folder in the 
Windows Start Menu (Windows 7) or App list (Windows 8/10). It can also be run from the 
BridgeWay Configuration Tool Desktop shortcut. 
 
When BWConfig is started, it will attempt to locate a BridgeWay module attached to the PC’s 
USB port. If a module is detected, the Connection Status icon will show a green circle with a 
chain link. 
 
If a module is not connected to the PC or is powered off when the tool is started, the 
Connection Status icon will show a yellow circle with a broken chain.  Make sure that the 
module is powered and the USB cable is connected. BWConfig will automatically detect the 
module. If the BridgeWay is not detected, disconnect the USB cable from the PC, wait 15 
seconds, then reconnect the cable. The module should be detected within a few seconds.  
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BWConfig User Interface 

Main View 

When BWConfig is run, the user is presented with the main view. The main view is divided into 
seven different areas, as shown in the figure below. Those areas are  

1. Menu 
2. View Selector 
3. Billboard 
4. View Area 
5. Event Log Pane 
6. Title Bar 
7. Connection Status Icon 

 

 
Figure 6. BWConfig Main View 
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Menus 

File Menu 

 
Figure 7, BWConfig File Menu 

 

New 

Creates a new workspace.   
The type of BridgeWay is selected in the submenu. 
This will create a new configuration for the specified module type 
with default configuration values. 

Open… 

Loads a previously saved workspace from a file with a .BWNXG 
extension.  
If the current workspace has unsaved changes, the user is given the 
option to save the changes before the new one is loaded. 

Save 
Saves the current workspace to a file.  
The current file name is shown in the title bar. If the current 
workspace is unnamed, a Save As runs instead. 

Save As… 
Asks the user for a file name, and then saves the current workspace 
to that file. 

Import… Creates a workspace from a legacy BridgeWay configuration file. 

Exit 
Exits BWConfig.  
If the current workspace has unsaved changes, the user is given the 
option of saving the changes before the tool is closed. 
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BridgeWay Menu 

 
Figure 8. BWConfig BridgeWay Menu 

 

Upload Configuration from 
BridgeWay → Current… 

Reads the current configuration running in the 
connected BridgeWay and creates a new 
workspace using those values. 

Upload Configuration from 
BridgeWay → Pending… 

Reads the pending configuration from the 
connected BridgeWay and creates a new 
workspace using those values. 

Download Configuration to 
BridgeWay… 

Writes the current workspace settings to the 
pending configuration of the connected 
BridgeWay. 
The module must be rebooted in order for any 
changes to the pending configuration to take 
effect. 

Restore BridgeWay to Factory 
Defaults… 

Sets the pending configuration in the connected 
BridgeWay to the default settings.  
The module must be rebooted in order for the 
default settings to take effect. 

Clear BridgeWay Faults… 
Clears any sticky faults in the connected 
BridgeWay and resets protocol counters. 

Set BridgeWay Run/Idle State… 
Switches the connected BridgeWay between Run 
and Idle mode. 

Update BridgeWay Firmware… 
Writes new firmware to the connected 
BridgeWay. 

Reboot BridgeWay Reboots the connected BridgeWay. 
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Logging Menu 

 
Figure 9. BWConfig Logging Menu 

 

View Event Log Shows/hides the Event Log Pane. 

Enable Trace Log Enables/disables diagnostic trace logging.  

View Trace Log Displays the Trace Log window. 

 
Note: Trace logging provides information about BWConfig operations and USB communications 
and may be used by Pyramid Solutions Technical Support to diagnose an issue. 
 
Help Menu 

 
Figure 10. BWConfig Help Menu 

 

User Manual 
Displays the user manual associated with the current 
BridgeWay type. 

About Displays information about BWConfig. 
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View Selector 

The view selector chooses which of the current workspace’s views will be displayed in the View 
Area -- Configuration View or Status View. 
 
Selecting the Gear icon will display the Configuration View. 
Selecting the Bits icon will display the Status View. 
 

View Area 

The current workspace’s Configuration and Status views are displayed in the View area. The 
View Selector chooses which view is visible. 
 

Billboard 

The Billboard area indicates the current view displayed and the BridgeWay type.  
 

Event Log Pane 

The Event Log Pane displays a list of events that have occurred since the BWConfig tool was 
started. These events include items such as errors, BridgeWay USB connections, loading and 
saving workspaces, importing configurations, etc.  
 
The contents of the event log can be copied to the Windows clipboard to aid Technical Support 
in troubleshooting issues. 
 

Title Bar 

The Title Bar displays the name of the current workspace.  
 
If a new workspace has not been saved, the Title Bar will display “New Workspace”. 
 
If the workspace has unsaved changes in the configuration data, the name will be followed by 
an asterisk (*). 
 

Connection Status Icon 

The connection status shows the current state of the BridgeWay USB communications. 
 

Connected 
 

Disconnected 
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Working with BridgeWay Configurations 

Current and Pending  

The BridgeWay module holds 2 sets of configuration settings, the Current configuration, and 
the Pending configuration. 
 
The Current configuration is the configuration settings that the module is currently using.  The 
Current configuration is loaded from flash memory when the BridgeWay is powered up.  
Changes made to the configuration in BWConfig do not affect the Current configuration. 
 
The Pending configuration is the configuration settings that are stored flash memory on the 
module.   The Pending configuration holds any changes that have been made in BWConfig.    
 

Uploading and Downloading 

When a configuration is Uploaded, the settings are read from the BridgeWay module into the 
current BWConfig workspace.   Either the Current or Pending configuration may be uploaded, 
allowing the workspace to be loaded with settings that are currently running or stored in flash 
respectively. 
 
When a configuration is Downloaded, the settings in the current BWConfig workspace are 
written to the BridgeWay module.   A downloaded configuration is always written to the 
Pending configuration stored in flash.  Downloaded configuration changes require a module 
reset to take effect. 
 

New Configuration Workspaces 

A new configuration workspace is created using the File → New… menu command.  New 
workspaces are filled with factory default settings for the type of BridgeWay being configured. 
 

Factory Default Configuration 

The BridgeWay may have its configuration reset to factory default settings.  This is done 
through the BridgeWay → Restore BridgeWay to Factory Defaults… menu command in 
BWConfig.   Factory default configuration settings are written to the Pending configuration.  
The module must be reset for the updated configuration to take effect. 
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Ethernet Network Configuration 

The Ethernet network configuration is viewed and updated in the Interfaces tab of the 
Configuration view. 
 

 
Figure 11. BWConfig Ethernet Network Configuration View 

 

Parameter Description Range Default 

IP Address 
The IP address the module will use. 
 
If DHCP is enabled this address is ignored.  

Valid IP 
address 

192.168.1.100 

Subnet Mask 
The subnet mask the module will use. 
 
If DHCP is enabled this mask is ignored. 

Valid IP 
subnet mask 

255.255.255.0 

Gateway  

The IP address of the network gateway. 
 
If DHCP is enabled this address is ignored.  
If no gateway is used on the network this 
may be set to 0.0.0.0. 

Valid IP 
address or 
0.0.0.0 

0.0.0.0 

DHCP  

DHCP is enabled if checked. 
 
If checked, the module will receive its IP 
configuration from a DHCP server on the 
network. 
If not checked, the module will use the IP 
configuration set here. 

Enabled 
Disabled 

Enabled 
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Parameter Description Range Default 

Address 
Conflict 
Detection 

ACD is enabled if checked. 
 
If checked, the module will check for, and 
defend against IP address conflicts as 
specified in the EtherNet/IP Specification 
Appendix F. 
If not checked, the module will send a 
single gratuitous ARP for an IP address 
claim. 

Enabled 
Disabled 

Enabled 

Hostname 

Ethernet IP hostname Up to 64 
characters 
may include 
letters, 
numbers and 
‘-‘. 

Empty 

Speed 

Ethernet network speed. 
 
If set to ‘Auto’ the module will auto 
negotiate speed. 

Auto 
10Mbps 
100Mbps 

Auto 

Duplex 

Ethernet network duplex. 
 
If set to ‘Auto’ the module will auto 
negotiate duplex. 

Auto 
Half 
Full 

Auto 

Protocols 

Select the Ethernet protocols that are 
active. 
 
Note: Unless the application requires both 
protocols, it is recommended not to 
enable both to reduce the number of open 
Ethernet ports for security reasons.  

Either or both 
protocols 
 

EtherNet/IP  
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Parameter Description Range Default 

Data Sizes 

The size in bytes of the I/O Table. 
 
Some EtherNet/IP devices only support 
smaller I/O connections.  Recommended 
input and output sizes for some devices 
are listed below: 
   ControlLogix  500/496 
   SLC 5/05  248/244 
   MicroLogix  252/248 

  In: 4–500 
  Out: 4–496  
 

In: 500 
Out: 496 

Modbus 
Timeout 

The Modbus Timeout option provides a 
means to detect the loss of the Modbus 
Scanner communications. 
 
If no Modbus requests are received within 
the configured timeout period, the module 
Run/Idle mode will be set to Idle. 
 
This parameter is only available if the 
Modbus protocol is enabled. 

1 – 65535 5 

Swap Bytes 

Modbus I/O byte swapping is enabled if 
checked. 
 
Enabling byte swapping will cause the 
Modbus I/O data to be swapped on 16-bit 
word boundaries when transferred 
between Modbus and DeviceNet. This is 
useful since Modbus is a Big-Endian 
network.  
 
This parameter is only available if the 
Modbus protocol is enabled. 
 
Note: Byte swapping has no effect on 
EtherNet/IP I/O data. 

Enabled 
Disabled 

Enabled 

Table 2. Ethernet Network Configuration Parameters 
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DeviceNet Network Configuration 

The DeviceNet network configuration is viewed and updated in the Interfaces tab of the 
Configuration view below the Ethernet network settings. 
 

 
Figure 12. BWConfig DeviceNet Network Configuration View 

 

Parameter Description Range Default 

Baud Rate 
The CAN network baud rate to be used 
for DeviceNet communications. 

125K 
250K 
500K 

125K 

MAC Address 
The network address the BridgeWay will 
use on the DeviceNet network. 

0 – 63  63 

Auto Baud 

Automatic baud rate detection is enabled 
when checked. 

 
Note: If the BridgeWay is the primary 
master on the DeviceNet network, do not 
enable automatic baud rate detection. 

Enabled 
Disabled 

Disabled 
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Parameter Description Range Default 

Active Node 
List 

Active node list option is enabled when 
checked. 
 
See the Active Node List section for 
details. 

Enabled 
Disabled 

Enabled 

Input Safe 
State 

Defines the state of data in the input 
table associated with a DeviceNet slave 
when the connection times out.  
 
Setting the safe state to “Retain Last 
State” will cause the slave’s data to 
freeze at the last value received from the 
slave.  
Setting the value to “Zero Data” will 
cause all input data associated with the 
slave to be set to zero. 
The “Set Values to -1” setting will cause 
all input data to be set to 0xFF. 

Retain 
0 
-1 

Retain 

Autoscan 

The Autoscan button will launch the 
Automatic Scan List Generation dialog. 
 
See the I/O Table Configuration Using 
Autoscan section for details. 

  

Table 3. DeviceNet Network Configuration Parameters 

 

Setting DeviceNet Network Configuration with Node Commissioning Tools 

The DeviceNet network configuration may also be set using a DeviceNet node commissioning 
tool like RSNetworx. The parameters discussed above may be set through the parameter 
editing function of these tools. See DeviceNet Configuration with RSNetworx  section for details 
on setting the DeviceNet network configuration using these tools. 
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I/O Table Configuration 

The I/O Table configuration is used define the content and format of the input and output 
buffers of the I/O Table. Data that is transferred in and out of DeviceNet slave data is mapped 
to locations within the I/O Table.   
 

Inputs Versus Outputs 

The input buffer of the I/O Table holds data that is received from DeviceNet slaves and can be 
read on the Ethernet network.  
 
The Output buffer of the I/O Table holds data that is received from the Ethernet network and is 
to be sent to DeviceNet slaves. 
 

I/O Configuration Limits 

The I/O configuration is limited as follows: 
• The maximum Input buffer size is 500 bytes.  It includes the 32-bit Status Register so actual 

DeviceNet slave input data size is limited to 496 bytes. 

• The maximum Output buffer size is 496 bytes.  It includes the 32-bit Command Register so 
actual DeviceNet slave output data size is limited to 492 bytes. 

 
I/O Table Configuration using DeviceNet Configuration Tools 

The layout of the I/O Table may be configured using a DeviceNet configuration tool.  This 
approach provides the most flexibility and control over the I/O Table layout and content as 
compared to the Autoscan feature.  
 
This manual is not intended to replace the user manual for the configuration tool; hence it will 
not provide details on using the tool. 
 
The next chapter provides an overview of the use of Rockwell Software’s RSNetWorx for 
DeviceNet. 
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I/O Table Configuration Using Autoscan 

The Autoscan feature allows a the DeviceNet master scan list and I/O Table layout to be 
automatically generated based on the DeviceNet slaves that are active on the network.   
The DeviceNet Autoscan dialog is displayed when the Autoscan button is pressed in the 
DeviceNet Network configuration pane of BWConfig. 
 

 
Figure 13. BWConfig DeviceNet Autoscan Dialog 

Running Autoscan 

Starting Autoscan: 
1. Set the Autoscan Time, which is the amount of time the BridgeWay will search for 

DeviceNet slaves to configure.   
2. Set the Bytes per Slave, which is the amount of space allocated in the Input or 

Output buffer for each slave. 
3. Press the Start Scanning button. 
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Autoscan in progress: 
4. Status area beneath the Start/Stop buttons will display the current status. 
5. As DeviceNet slaves are found on the network, the status area next to each MAC 

address will display “Discovered”, then “Configuring”, then “Configured” 
 
When Autoscan is completed the status area will be blank and each DeviceNet slave that 
was successfully added to the configuration will read “Configured”. 
 
I/O Table Layout after Autoscan 

Autoscan configures the I/O Table layout based on the Bytes per Slave configuration.  Each 
slave (MAC ID’s 0-62) is allocated Bytes per Slave bytes in the Input or Output buffer, up 
till the end of the buffer. 
 
 Slave Data Location = BytesPerSlave x MAC_ID 
 
For example, if Bytes per Slave is set to 8.  Data for slave 0 is at offset 0, and for slave 10 is 
at offset 80. 
 
Only slave entries that fit in the configured I/O Table size will be configured.  If the 
BytesPerSlave x MAC_ID is larger than the Input or Output Sizes configured in the Ethernet 
network configuration, that slave will not be added to the configuration. 
 
Note: If a slave’s I/O connection size is larger than the configured Bytes per Slave, only the 
first Bytes per Slave bytes of the connection data will be mapped into the I/O Table.   
 
Note: Non-existent slaves take up space in the I/O Table.  If your DeviceNet network is 
configured with MAC addresses that are spread out, there will be a lot of wasted space in 
the I/O Table. 
 
I/O Connections Created by Autoscan 

Each DeviceNet slave that is discovered during Autoscan is interrogated to determine 
what Predefined Connection Set connections are supported.  The BridgeWay allocates a 
single I/O from the connections set using the following priority: 
 

1. Change of State 
2. Polled 
3. Strobe 
4. Cyclic 

 
Once a connection type is found, that is what is used for the configuration regardless of 
what other connection types may be supported by the slave. 
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Quick Start 

This chapter provides a step by step explanation of configuration of the Ethernet-DeviceNet 
BridgeWay. It is intended to be used as a beginner’s guide to configuring and using the 
BridgeWay using RSNetWorx for DeviceNet. 
 

Ethernet Network Configuration 

See the Ethernet Network Configuration section for details on the configuration parameters for 
the Ethernet network interface that can be set in BWConfig. 
 

DeviceNet Network Configuration 

The configuration of the DeviceNet network interface involves using a tool to set at least the 
BridgeWay’s MAC ID and baud rate.   This may be done via BWConfig or through a DeviceNet 
commissioning tool.  
 
Note: The BridgeWay defaults to 125K baud out of the box. If your DeviceNet network is not 
running at 125K baud, the BridgeWay must configured before connecting it to the network.  Do 
not attempt to commission the BridgeWay on a live DeviceNet network configured at a 
different baud rate. 
 

 

DeviceNet Configuration with BWConfig 

See the DeviceNet Network Configuration section for details on the configuration parameters 
for the DeviceNet network interface that can be set in BWConfig. 
 
If BWConfig is used for DeviceNet node commissioning, skip to DeviceNet I/O Configuration 
below. 
 
 
  



  Quick Start 
 

 
© Pyramid Solutions 30 PUB-BW4030-002 

DeviceNet Configuration with RSNetworx 

This section provides a walk-through of how to set the DeviceNet network configuration 
parameters using RSNetworx for DeviceNet. 
 
Note: The procedure below uses the BridgeWay Ethernet bridging which allows the PC running 
RSNetworx to communicate with the BridgeWay over Ethernet.  The module may also be 
configured from DeviceNet if the PC has a DeviceNet network interface. 
 
Step 1: Connect the PC and BridgeWay to the Ethernet network 

Make sure that the BridgeWay and the PC running RSNetworx are connected to the same 
Ethernet network with the same subnet configuration.  The BridgeWay does not need to be 
connected to a DeviceNet network. 
 
Step 2: Set up RSLinx EtherNet/IP driver 

If the RS Tools have not been set up to communicate on Ethernet, the following steps must be 
done. 

1. Open RSLinx 
2. Select Communications → Configure Drivers… 
3. Pull down the Available Drivers combo box and select EtherNet/IP Driver 
4. Press Add New… 
5. Select the appropriate PC Ethernet network interface  

A new driver entry should be added to the list 
6. Close RSLinx 

 
Step 3: Register the BridgeWay EDS file 

RSNetWorx requires an electronic data sheet (EDS) to recognize a device and its capabilities. An 
EDS file is available on the Pyramid Solutions web site. The EDS file must be registered with 
RSNetWorx before configuration can continue. 

1. Open RSNetworx 
2. Select the Tools → EDS Wizard… 
3. Click on Next. 
4. Select Register an EDS File and click Next. 
5. Select Register a Single File and enter, or browse to, the location of the EDS file for 

BridgeWay. 
6. Click Next or Finish for the remaining option screens. 
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Step 4: Connect to the BridgeWay with RSNetworx 

RSNetWorx provides the ability to browse the network to locate and identify devices. 
1. Select the Network → Online 
2. Expand the EtherNet/IP driver that was added above 

The BridgeWay should appear in the list of connected devices 
3. Expand the BridgeWay tree entry 

DeviceNet network entry should appear below the BridgeWay 
4. Select the DeviceNet entry and press OK. 
5. Press OK to the upload/download notice 

RSNetworx will upload the configuration and display the network devices.  
The BridgeWay module should appear at its configured DeviceNet MAC address. 

 
Step 5: Set the DeviceNet MAC ID and Baud Rate with RSNetworx 

1. Select the Tools → Node Commissioning 
2. Click Browse 
3. Expand the EtherNet/IP driver that was added above 

The BridgeWay should appear in the list of connected devices 
4. Expand the BridgeWay tree entry 

DeviceNet network entry should appear below the BridgeWay 
5. Select the DeviceNet entry 

The connected devices will appear in the right pane 
6. Double click on the BridgeWay icon in the right pane 

The Node Commissioning dialog MAC and Baud Rate entries will be filled with 
the current BridgeWay settings 

7. Enter the desired MAC address and/or Baud Rate 
8. Click Apply 

 
Note: The BridgeWay will automatically reset if a new MAC ID is entered. If only the baud rate is 
changed the BridgeWay must be power cycled before the new baud rate will take effect. 
 
Note: When the MAC ID is changed, any BridgeWay I/O configuration is cleared. 
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I/O Table Configuration 

I/O Table configuration involves setting the DeviceNet master scan list and I/O Table mapping.   
This may be done through a DeviceNet network configuration tool like RSNetworx for 
DeviceNet, or with the Autoscan feature. 
 

Using Autoscan 

The BridgeWay Autoscan feature will generate a scan list and I/O Table mapping based on the 
active nodes on the DeviceNet network.  See I/O Table Configuration Using Autoscan for 
complete details of the feature. 
 

Using RSNetworx 

Note: The steps below assume that the RSLinx EtherNet/IP driver is set up and that RSNetworx 
is successfully connected to the BridgeWay.  Follow the steps 1-4 in DeviceNet Configuration 
with RSNetworx to accomplish this. 
 

1. Select Network → Browse Single Scan 
Wait for browsing to complete 
 

2. Select Network → Upload 
Wait device configuration to be uploaded from the devices 
 

3. Double click on the BridgeWay icon  
The module description dialog is displayed 
 

4. Select the Scanlist tab in the dialog 
The tab displays 2 columns. The left column is a list of available devices; these are 
slaves that may be added to the scan list. The right column is the scan list 
configuration; these are slaves that are configured in the scan list. 
 

5. Check the AutoMap on Add check box 
If AutoMap is enabled, RSNetworx will automatically map the slave I/O data into 
the I/O Table.  If it is disabled the mapping of each slave’s data must be done 
manually. 

 

6. Select the desired slave(s) from the available devices column. Click the “>” button to 
move them to the scan list. 

 
7. Select the Input tab in the dialog  

The Input tab is divided into 2 panes.  The top pane gives a list of the slaves in the 
scan list. The bottom pane shows the layout of the Input buffer, indicating the 
location that each slave’s input data will be placed. This is the format of the 
input data that will be sent to the Ethernet controller.  
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8. Select the Output tab in the dialog  
The Output tab is divided into 2 panes. The top pane gives a list of the slaves 
in the scan list. The bottom pane shows the layout of the Output buffer, 
indicating the location that each slave’s output data will be placed. This is 
the format of the output data that will be received from the Ethernet 
controller. 

 
9. Click Apply, then Yes to download the scan list configuration to the BridgeWay. 

The BridgeWay creates connections and starts scanning DeviceNet slaves as 
soon as the scan list is downloaded.  

 
Note: Automap is used in this example for simplicity. In some cases, the user may wish to 
organize the I/O data in other ways; this can be done using the Advanced data table editor 
in the Input and Output tabs. See the RSNetWorx manual for complete details. 
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EtherNet/IP Interface 

EtherNet/IP is based on the Common Industrial Protocol (CIP), which is also the 
application layer for DeviceNet and ControlNet, to exchange data between nodes. 

Product Features 

The BridgeWay supports EtherNet/IP Adapter Class functionality. Being an I/O Server it can 
respond to requests for I/O messages but it does not generate such requests. The 
BridgeWay supports Message Server functionality. This means it can act as a target for 
explicit messaging. 

CIP Objects 

CIP makes use of abstract object modeling to describe the communications interface of a 
product. Objects are well defined subsets of a device’s functionality. They have functions 
that they perform called Services and data variables called Attributes. If more than one 
copy of an object is needed each copy is called an Instance. The BridgeWay supports the 
objects required by the EtherNet/IP specification. 

CIP Messaging 

The regular or repeated transport of a specific set of data items is known as Implicit 
Messaging. Both parties agree in advance and allocate resources for the connection being 
used to transport the data as well as the transport rate and class. The connection ID within 
the Implicit message defines the meaning of the data.  The term Implicit Messaging can be 
interchanged with the term I/O Messaging. 
 
A one-time transport of a data item where both parties do not know in advance what’s 
being transferred is known as Explicit Messaging. Explicit messaging is used for point to 
point, or request/response type messaging. The protocol of the message data describes 
(addresses) the data to be transferred. In object modeling the address is in terms of class 
number, instance number, and attribute number. 
 
Messages can be sent as Connected or Unconnected. With Connected Messaging device 
resources are reserved for data transfer and are dedicated and always available. 
Unconnected messaging provides a means for a device to send a request without 
establishing a connection prior to data transfer. This is accomplished through the UCMM 
or Unconnected Message Manager of the EtherNet/ IP protocol. With UCMM all objects 
are accessible. 
 
All Explicit Messages have message data defined in a format called the Message Router 
Protocol Data Unit (MR_PDU). There are Requests and Responses. 
 
The MR_PDU Request format includes a Service code, Path Size, Path, and data, if any, for 
the Service. The Path is an encoded series of bytes or Segments describing the location of 
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the data item involved in the transfer. The Logical Segment is most often used. It describes 
the Class, Instance, and Attribute of the data. 
 
The BridgeWay will handle up to 8 concurrent unconnected transactions. Up to 6 class 3 
(messaging) connections are supported. 

I/O Messaging 

The BridgeWay allows an EtherNet/IP Scanner access to the I/O Table. The data received 
from the DeviceNet slaves is collected in the Input buffer (IN) of the BridgeWay and 
becomes the EtherNet/IP Input data to the EtherNet/IP scanner. EtherNet/IP Output data 
from the scanner is stored in the BridgeWay’s Output buffer (OUT) and transmitted to the 
DeviceNet slaves. 
 

EtherNet/IP 
Scanner

BridgeWay

IN OUT

Slave 
Node

Slave 
Node

Slave 
Node

Slave 
Node

Ethernet

DeviceNet

EtherNet/IP
I/O Output

EtherNet/IP
I/O Input

Slave Output DataSlave Input Data

 
Figure 14. BridgeWay I/O Transfer with EtherNet/IP 
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Assembly Objects and Connections 

Assembly Instances 

There are 3 Assembly Object instances accessible from EtherNet/IP: input, output, and 
status. The input and output assemblies are linked to the Input and Output buffers. The 
status assembly provides status information about the BridgeWay. 
 
The assembly instances associated with these 3 assemblies are listed below. 
 

Assembly 
Instance 

Description Size in Bytes 

100 Input 500 max 

101 Status 128 

150 Output 496 max 

Table 4. EtherNet/IP Assembly Instances 

 

Connection Points 

Class 1 connections can be established to these assemblies using the following connection 
points.  
 

Conn 
Point 

Description Size in 
Bytes 

Use 

198 Input-Only 
Heartbeat 

0 Output connection point for input-only 
connections. 

199 Listen-Only 
Heartbeat 

0 Output connection point for listen-only 
connections. 

100 Input 4-500 Input connection point. 

101 Status 128 Input connection point. 

150 Output 8-500 Output connection point. 

Table 5. EtherNet/IP Connection Points 

The Input connection size is the Input Data Size configured in the Ethernet Network 
configuration. 
 
The Output connection size is the Output Data Size configured in the Ethernet Network 
configuration plus 4 bytes for the Run/Idle header. 
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Input Assembly Format 

The input assembly contains a 32-bit status register followed by the DeviceNet slave input 
data. 
 

Byte 
Offset 

Size in 
Bytes 

Description 

0 4 Status register. 

4 Up to 496 DeviceNet slave input data. 

Table 6. EtherNet/IP Input Assembly Format 

The DeviceNet slave input data format and content is determined by the scan list and I/O 
mapping configuration.   
 
The status register is a bit string with the following bit definitions. 
 

Bit Description 

0 BridgeWay is in Run mode. (Cleared if in Idle mode.) 

1 DeviceNet network interface is faulted. 

2 DeviceNet network interface is disabled. 

3 Communication has failed with at least 1 DeviceNet slave. 

4 At least 1 DeviceNet slave has failed verification. 

5 DeviceNet network interface is bus-off. 

6 Duplicate MAC ID error. 

7 No DeviceNet power. 

8-31 Reserved 

Table 7. EtherNet/IP Input Status Register Bit Definitions 
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Output Assembly 

The output assembly contains a 32-bit command register followed by the DeviceNet slave 
output data. 
 

Byte 
Offset 

Size in 
Bytes 

Description 

0 4 Command register. 

4 Up to 
492 

DeviceNet slave output data. 

Table 8. EtherNet/IP Output Assembly Format 

 
The DeviceNet slave output data format and content is determined by the scan list and I/O 
mapping configuration.   
 
Note: EtherNet/IP I/O connections append a 32-bit Run/Idle header at the front of the 
output data. The actual output data transferred in the I/O connection includes this extra 4 
bytes at the front of the output assembly described above.  The header adds 4 bytes to 
the connection size but is hidden from the user in both the BridgeWay and the 
EtherNet/IP controller. 
 
The Command register is a bit string with the following bit definitions. 
 

Bit Description 

0 Local Run Mode 
Used in conjunction with the Run Mode bit in the Run/Idle register to 
determine the run mode of the BridgeWay. Both bits must be set for the 
BridgeWay to be in Run mode; otherwise the module will be in Idle 
mode. 

1 Reserved 

2 Disable DeviceNet network 

3 Reserved 

4 Reset the BridgeWay module 

5-31 Reserved 

Table 9. EtherNet/IP Output Command Register Bit Definitions  
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Status Assembly 

The status assembly is a collection of status and diagnostic information for the BridgeWay 
DeviceNet interface. The information in the assembly is updated once a second. 
 

Byte 
Offset 

Size in 
Bytes 

Data Type Name Description 

0 4 UDINT Scan 
Counter 

The number of DeviceNet I/O scans 
that have taken place since the 
BridgeWay was powered up. 

4 8 64-bit Bit- 
string 

Faulted 
Node Table 

Indicates which DeviceNet slaves are 
faulted. 
 
Each bit represents the status of the 
slave at the corresponding MAC ID. 

12 8 64-bit Bit- 
string 

Auto Verify 
Error Table 

Indicates which DeviceNet slaves are 
the incorrect device type. 
 
Each bit represents the status of the 
slave at the corresponding MAC ID. 

20 8 64-bit Bit- 
string 

Idle Node 
Table 

Indicates which DeviceNet slaves are 
in Idle mode. 
 
Each bit represents the status of the 
slave at the corresponding MAC ID. 

28 8 64-bit Bit- 
string 

Active Node 
Table 

Indicates which DeviceNet nodes are 
configured in the BridgeWay’s scan 
list.  
 
Each bit represents a device at the 
corresponding MAC ID. If the bit is 
set, that device is being actively 
scanned by the BridgeWay’s 
DeviceNet master. 
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Byte 
Offset 

Size in 
Bytes 

Data Type Name Description 

36 4 ASCII[4] Status 
Display 

Mimics a 4-character alpha-numeric 
display. 
 
If there are no faults, the display 
indicates the BridgeWay MAC ID and 
its Run/Idle status. 
If there are faults, the display will 
scroll through the MAC IDs of the 
faulted nodes and display the error 
code associated with each. See 
DeviceNet Node Status Values 
for a list of error codes. 

40 1 USINT BridgeWay 
MAC ID 

The DeviceNet MAC ID of the 
BridgeWay. 

41 1 USINT Scanner 
Status 

The current status of the DeviceNet 
scanner.  
 
See DeviceNet Node Status Values 
for a list of status and error codes. 

42 1 USINT Scrolling 
MAC ID 

The scrolling address and status 
fields scroll through the address and 
status of all DeviceNet slaves that are 
faulted.  
 
This scrolling includes the BridgeWay 
scanner itself. 
 
If there are no faulted nodes, both 
the scrolling address and status are 
set to 0. 
 
The scrolling fields change once a 
second. 

43 1 USINT Scrolling 
Status 

44 20 USINT[20] Reserved  
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Byte 
Offset 

Size in 
Bytes 

Data Type Name Description 

64 64 USINT[64] Node Status 
Table 

The current status of each DeviceNet 
slave node.  
 
Each array element is the status of 
the node at the corresponding MAC 
ID.  The BridgeWay scanner status 
appears at the entry associated with 
the BridgeWay MAC ID. 
 
A non-zero status indicates that 
there is an issue with the associated 
node. A status of 0 indicates “OK” 
and is used for nodes both in and out 
of the scan list. 
 
See DeviceNet Node Status Values 
for a list of status codes. 

Table 10. EtherNet/IP Status Assembly Format 
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Run/Idle Control 

The Run/Idle mode of the BridgeWay determines whether the module can update output 
data being sent to the DeviceNet slaves.  In Idle mode, the module only monitors input 
data from the slaves and does not send any output data updates. 
 

Run/Idle Control with I/O Connection 

Run/Idle mode is controlled by the EtherNet/IP controller through an I/O connection using 
2 bits in the output data:  bit 0 in the Run/Idle Header and bit 0 in the Command Register.  
 
Both bits must be set to put the BridgeWay in Run mode.  If either of the 2 bits is cleared 
the BridgeWay will revert to Idle mode. 
 
Note that the Run/Idle Header bit is not directly accessible in most controllers. The Run 
mode bit in the Run/Idle Header is controlled by the Run/Program mode of the controller.  
When the controller is put into Run mode, the bit is set in the Run/Idle header. 
 

Run/Idle Control with Explicit Messages 

If I/O connections are not being used, the Run/Idle mode of the BridgeWay may be 
controlled though explicit writes to the Output assembly.     
 
If bit 0 of the Command register is set when the Output assembly is written, the module 
will be put into Run mode.  The module will remain in Run mode until an Output assembly 
write is made with the bit cleared. 
 
If an I/O connection is active, explicit writes to the Output assembly are rejected, and the 
Run/Idle mode is controlled by the bit status in the I/O connection output data. 
 

Interaction with Modbus TCP 

If both EtherNet/IP and Modbus TCP are enabled in the EtherNet Network configuration, 
the BridgeWay will support messages on either protocol and will support requests 
simultaneously. 
 
If an EtherNet/IP I/O connection is active, Modbus TCP requests are limited to monitor-
only.  Any write requests made on Modbus will be rejected while an EtherNet/IP I/O 
connection is active. 
 
If all communication with the module is done via explicit messages on EtherNet/IP, all 
writes to the output data from either protocol will be accepted.  The output data will be 
set to the latest write received regardless of protocol type.  
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I/O Data Summary 

The following diagram illustrates how the various components of the Input buffer are used 
to create the input assembly and connection data accessible from EtherNet/IP. 
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Figure 15. EtherNet/IP Input Data Summary 

 
The following diagram illustrates how the various components of the Output buffer are 
used to create the output assembly and connection data accessible from EtherNet/IP. 
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Figure 16. EtherNet/IP Output Data Summary 
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Using ControlLogix with the BridgeWay 

When configuring I/O connections between a Rockwell Automation ControlLogix 
EtherNet/IP scanner and the BridgeWay, the Generic EtherNet/IP device type should be 
used. 
 
The Run/Idle register is automatically inserted at the front of the output data and the 
application has no control over its use. The Run Mode bit in the header is set according to 
the Run/Program mode of the controller. 
 
The connection output size in the RSLogix configuration must be set to the Output Data 
Size configured in the Ethernet Network configuration in BWConfig, which defaults to 496 
bytes.  (Although the Run/ Idle header adds 4 bytes to the actual connection size, it is 
automatically added by the controller and does not come into play in this size). The 
connection input size must be set to the Input Data Size configured in the Ethernet Network 
configuration in BWConfig, which defaults to 500 bytes.   
 
The status assembly may also be monitored by configuring the connection in RSLogix with 
a “with status” Comm Format. The status size is 128 bytes. 
 
The status output in the RsLogix connection must be set to the Input Only heartbeat 
connection point of 198. 
 
The BridgeWay does not support a configuration assembly. The configuration instance in 
the RSLogix connection configuration may be set to any number since it will be ignored.  
Set the configuration size to 0. 
 
The figure below shows a typical ControlLogix device configuration. 
 

 
Figure 17. ControlLogix Connection Configuration 
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Modbus TCP Interface 

The BridgeWay implementation of the Modbus TCP server is done according to the 
Modbus TCP specification 1.0. 
 
The module can handle 4 simultaneous connections. 
 

Supported Modbus Commands 

The following Modbus TCP commands are supported by the BridgeWay. 
 

Function Code Function Name 

1 Read Coils 

2 Read Input Discrete 

3 Read Holding Registers 

4 Read Input Registers 

5 Force Single Coil 

6 Write Single Register 

15 Force Multiple Coils 

16 Write Multiple Registers 

22 Mask Write Registers 

Table 11. Supported Modbus Commands 
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Supported Modbus Exception Codes 

An exception code is returned in the Modbus response when the BridgeWay is unable to 
service the Modbus request that was received. The following exception codes are used by 
the BridgeWay. 
 

Exception 
Code 

Name Description 

01 Illegal Function The BridgeWay does not support the function 
code requested 

02 Illegal Data 
address 

The register address received in the request is 
outside the allowed I/O Table range 

03 Illegal Data 
Value 

The data in the request is invalid 

Table 12. Supported Modbus Exception Codes 
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Modbus TCP Register Addressing 

The BridgeWay Input and Output buffers in the I/O Table and the status assembly are 
mapped to ranges of Modbus register addresses.    
 

Modbus Register 101 

There are 4 types of Modbus registers: 
Coils Output bits.   

Coils are used to address the output buffer in the I/O Table at 
the bit level. 
 

Input Status Bits Input bits. 
Input Status bits are used to address the input buffer in the I/O 
Table or the status assembly at the bit level. 
 

Input Registers Input words. 
Input Registers are used to address the input buffer in the I/O 
Table or the status assembly at the 16-bit word level. 
 

Holding Registers Output words. 
Holding Registers are used to address the output buffer in the 
I/O Table at the 16-bit word level. 

 
Register addresses are 1’s offset.  The first location in the I/O area is addressed as register 
1.   
 
Bit registers are mapped most significant bit first.  Hence register 1 corresponds to bit 15 
of the first 16-bit word. 
 
Depending on the application, controller or configuration software, Modbus register 
addresses are depicted in several different ways to specify the type of register.   

• The type of register is specified with the register number. 

• The Modicon Convention uses a prefix on the number to specify the type of 
register, followed by a 4 digit register number. 

• The Extended Modicon Convention uses a 5 digit register number after the prefix 
to allow for a larger register range. 

 

 Modicon Addresses Extended Modicon 
Addresses 

Coils 00001 – 09999 000001 – 065535 

Input Status Bits 10001 – 19999 100001 – 165535 

Input Registers 30001 – 39999 300001 – 365535 

Holding Registers 40001 – 49999 400001 – 465535 
Table 13. Modbus Register Addressing Schemes 
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Input Addressing 

 Starting Input Register: 1 (30001 or 300001 also 40001 or 400001) 
 Register Count:  up to 250 
 
 Starting Input Status Bit: 1 (10001 or 100001 also 000001) 
 Bit Count:   up to 4000 
 
Note: Input data may also be read using Holding Register or Coil functions in the same 
register range. 
 
The full range is dependent on the Input Data Size configured in the Ethernet Network 
configuration. 
 

Input 
Register 

Input Status Bit Address 

15 14 13 12 11 10 9 ... 1 0 

1 1 2 3 4 5 6 7 ... 15 16 

2 17 18 19 20 21 22 23 ... 31 32 

.....           

250 3985 3986 3987 3988 3989 3990 3991 ... 3999 4000 

Table 14. Modbus Addressing for Input Buffer 
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Output Addressing 

 Starting Holding Register: 1027 (41027 or 401027) 
 Register Count:  up to 248 
 
 Starting Coil:   16417 (016417) 
 Coil Count:   up to 3968 
 
The full range is dependent on the Output Data Size configured in the Ethernet Network 
configuration. 
 
Note: The Legacy BridgeWay Modbus TCP interface started the Output Register addresses 
at 1025, but included the equivalent of the EtherNet/IP Run/Idle Header.  Current 
BridgeWay’s do not support the extra Run/Idle Header in the Modbus output data.  
Holding Registers 1025 and 1026 (41025 and 41026) are supported to maintain backward 
compatibility, but serve no functional purpose. 
 

Holding 
Register 

Coil Bit Address 

15 14 13 12 11 10 9 ... 1 0 

1027 16417 16418 16419 16420 16421 16422 16423 ... 16431 16432 

1028 16433 16434 16435 16436 16437 16438 16439 ... 16447 16448 

...           

1274 20369 20370 20371 20372 20373 20374 20375 ... 20383 20384 

Table 15. Modbus Addressing for Output Buffer 
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Status Addressing 

 Starting Input Register: 2051 (32051 or 302051 also 42051 or 402051) 
 Register Count:  64 
 
 Starting Input Status Bit: 32801 (132801 also 032801) 
 Bit Count:   1024  
 
Note: Status data may also be read using Holding Register or Coil functions in the same 
register range. 
 

Input 
Register 

Input Status Bit Address 

15 14 13 12 11 10 9 ... 1 0 

2051 32801 32802 32803 32804 32805 32806 32807 ... 32815 32816 

2052 32817 32818 32819 32820 32821 32822 32823 ... 32831 32832 

...           

2114 33809 33810 33811 33812 33813 33814 33815 ... 33823 33824 

Table 16. Modbus Addressing for Status Data 

 

Modbus Addressing Examples 

Word Addressing Examples 

• Input buffer word 0  Input Register 1, 30001, or 300001 
Holding Register 1, 40001, or 400001 
 

• Input buffer word 10   Input Register 11, 30011, 300011 
Holding Register 11, 40011, 400011 

 

• Output buffer word 0  Holding Register 1027, 41027, or 401027 
 

• Output buffer word 100 Holding Register 1127, 41127, or 401127 
 
Bit Addressing Examples 

• Input buffer bit 0  Input Status bit 16, 10016, or 100016 

• Input buffer bit 15  Input Status bit 1, 10001, or 100001 
 

• Output buffer bit 0  Coil 16432 or 016432 

• Output Table bit 15  Coil 16417 or 016417 
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Register Data Content 

Input Data 

The input data contains a 32-bit status register followed by the DeviceNet slave input data. 
 

Modbus 
Input 

Register 

Register 
Count 

Description 

1 2 Status register 

3 Up to 248 DeviceNet slave input data 

Table 17. Modbus TCP Input Data Format 

The DeviceNet slave input data format and content is determined by the scan list and I/O 
mapping configuration.   
 
The status register is a bit string with the following bit definitions. 
 

Bit Description 

0 BridgeWay is in Run mode. (Cleared if in Idle mode.) 

1 DeviceNet network interface is faulted. 

2 DeviceNet network interface is disabled. 

3 Communication has failed with at least 1 DeviceNet slave. 

4 At least 1 DeviceNet slave has failed verification. 

5 DeviceNet network interface is bus-off. 

6 Duplicate MAC ID error. 

7 No DeviceNet power. 

8-31 Reserved 

Table 18. Modbus TCP Input Status Register Bit Definitions 
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Output Data 

The output data contains a 32-bit command register followed by the DeviceNet slave 
output data. 
 

Modbus 
Holding 
Register 

Register 
Count 

Description 

1025 2 Legacy Run/Idle Register 
Note: Writes to these registers are ignored 

1027 2 Command register 

1029 Up to 246 DeviceNet slave output data 

Table 19. Modbus TCP Output Data Format 

The DeviceNet slave output data format and content is determined by the scan list and I/O 
mapping configuration.   
 
The Command register is a bit string with the following bit definitions. 
 

Bit Description 

0 Local Run Mode 
Used in conjunction with the Run Mode bit in the Run/Idle register to 
determine the run mode of the BridgeWay. Both bits must be set for the 
BridgeWay to be in Run mode; otherwise the module will be in Idle 
mode. 

1 Reserved 

2 Disable DeviceNet network 

3 Reserved 

4 Reset the BridgeWay module 

5-31 Reserved 

Table 20. Modbus TCP Output Command Register Bit Definitions 

  



  Modbus TCP Interface 
 

 
© Pyramid Solutions 53 PUB-BW4030-002 

Status Data 

The status data is a collection of status and diagnostic information for the BridgeWay 
DeviceNet interface. The information in the assembly is updated once a second. 
 

Modbus 
Input 

Register 

Register 
Count 

Name Description 

2051 2 Scan 
Counter 

The number of DeviceNet I/O scans that 
have taken place since the BridgeWay was 
powered up. 

2053 4 Faulted 
Node Table 

Indicates which DeviceNet slaves are 
faulted. 
 
This is a 64-bit bit string with each bit 
representing the status of the slave at the 
corresponding MAC ID. 

2057 4 Auto Verify 
Error Table 

Indicates which DeviceNet slaves are the 
incorrect device type. 
 
This is a 64-bit bit string with each bit 
representing the status of the slave at the 
corresponding MAC ID. 

2061 4 Idle Node 
Table 

Indicates which DeviceNet slaves are in 
Idle mode. 
 
This is a 64-bit bit string with each bit 
representing the status of the slave at the 
corresponding MAC ID. 

2065 4 Active 
Node Table 

Indicates which DeviceNet nodes are 
configured in the BridgeWay’s scan list.  
 
This is a 64-bit bit string with each bit 
representing a device at the 
corresponding MAC ID. If the bit is set, 
that device is being actively scanned by 
the BridgeWay’s DeviceNet master. 
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2069 2 Status 
Display 

Mimics a 4-character alpha-numeric 
display. 
 
If there are no faults, the display indicates 
the BridgeWay MAC ID and its Run/Idle 
status. 
If there are faults, the display will scroll 
through the MAC IDs of the faulted nodes 
and display the error code associated with 
each. See DeviceNet Node Status Values 
for a list of error codes. 

2071 1 BridgeWay 
MAC ID 

The DeviceNet MAC ID and current status 
of the BridgeWay DeviceNet scanner.  
 
See DeviceNet Node Status Values 
for a list of status and error codes. 

Scanner 
Status 

2072 1 Scrolling 
MAC ID 

The scrolling address and status fields 
scroll through the address and status of all 
DeviceNet slaves that are faulted.  
 
This scrolling includes the BridgeWay 
scanner itself. 
 
If there are no faulted nodes, both the 
scrolling address and status are set to 0. 
 
The scrolling fields change once a second. 

Scrolling 
Status 

2073 10 Reserved  
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2083 32 Node 
Status 
Table 

The current status of each DeviceNet slave 
node.  
 
This is a byte array with each array 
element being the status of the node at 
the corresponding MAC ID.  The 
BridgeWay scanner status appears at the 
entry associated with the BridgeWay MAC 
ID. 
 
A non-zero status indicates that there is an 
issue with the associated node. A status of 
0 indicates “OK” and is used for nodes 
both in and out of the scan list. 
 
See DeviceNet Node Status Values 
for a list of status codes. 

Table 21. Modbus TCP Status Data Format 
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Run/Idle Control 

The Run/Idle mode of the BridgeWay determines whether the module can update output 
data being sent to the DeviceNet slaves.  In Idle mode, the module only monitors input 
data from the slaves and does not send any output data updates. 
 
If bit 0 of the Command register (Holding register 1027) is set, the module will be put into 
Run mode.  The module will remain in Run mode if there is an active Modbus TCP 
connection and Holding register 1027 is not written with bit 0 cleared. 
 
If the Modbus TCP connection is closed, the module will immediately change to Idle mode. 
 
If no Modbus requests are received within the configured Modbus TCP Timeout period, 
the module will change to Idle mode. 
 

Interaction with EtherNet/IP 

See the Interaction with Modbus TCP section for details. 
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I/O Data Summary 

The following diagram illustrates how the various components of the Input buffer are used 
to create the input data accessible from Modbus TCP. 
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Figure 18. Modbus TCP Input Data Summary 

 
The following diagram illustrates how the various components of the Output buffer are 
used to create the output data accessible from Modbus TCP. 
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Figure 19. Modbus TCP Output Data Summary 
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I/O Data Endian Format 

The BridgeWay transfers I/O data between Modbus TCP and DeviceNet without regard to 
data content or format. Due to this, the user is responsible for making sure that the 
devices on either network understand the format of the data. 
 
DeviceNet is a little-endian protocol; values are transmitted least significant byte first. 
Hence, all data in the I/O Table is assumed, by the DeviceNet nodes, to be stored as little 
endian. 
 
Modbus TCP is a big-endian protocol; values are transmitted most significant byte first. 
 
The Swap I/O Bytes option in the Ethernet Network configuration will swap the bytes of 
each 16-bit word in the Input, Output, and Status data. This will aid in the transformation 
between the big and little-endian networks. However, care must be taken to assure that 
DeviceNet slave data is mapped to 16-bit word boundaries for this feature to be fully 
effective.   
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DeviceNet Interface 

Network Communication 

The Ethernet – DeviceNet BridgeWay acts as a DeviceNet Master or a slave. The 
BridgeWay, as a master, can exchange I/O data with up to 63 nodes. The module can also 
act as a slave to another DeviceNet Master, exchanging the contents of the I/O Tables 
with the second master. 
 

Automatic Baud Rate Detection 

Depending on its configuration, the BridgeWay can set its DeviceNet baud rate 
automatically. If the autobaud option is enabled, the module will detect the current 
network baud rate and set its baud rate accordingly before joining the network. If the 
option is disabled, the module will join the network with the configured baud rate. 
 

Slave Device Communication 

The BridgeWay continuously attempts to establish connections with devices configured in 
the scan list (list of configured slaves). Once connections are established, the module 
performs all necessary steps to configure the required I/O messaging. 
 
The BridgeWay provides explicit message proxy services for all group 2 only slaves. Once 
any Group 2 only devices are configured, the BridgeWay sends “keep alive” messages to 
the devices in addition to the I/O messages. This function prevents the explicit message 
connections between the BridgeWay and the slave from timing out. This eliminates the 
need to re-establish an explicit connection should the BridgeWay need serve as a proxy. 
 

Scan Cycles 

The BridgeWay employs a scan cycle for producing poll and strobe I/O messages. A scan 
cycle consists of the following: 
 

• A bit-strobe output message (if any devices in the scan list are configured for bit-
strobe). 

• Poll command messages for each device configured for polled I/O. 

• A configurable delay before the next scan cycle. 
 

The configurable delay is the Inter-Scan Delay (ISD). The ISD is a Scanner Configuration 
Object attribute. The delay begins when the last poll command message is transmitted. 
 
The BridgeWay also supports a background polling mechanism. A foreground to 
background polling ratio can be specified to allow slower polling of devices at certain scan 
cycle intervals. 
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I/O Message Types 

The BridgeWay supports all I/O messaging types specified by the DeviceNet protocol. 
These include strobe, poll, COS, COS Unacknowledged, Cyclic, and Cyclic Unacknowledged 
I/O messages. I/O messaging and I/O parameters are configured using the DeviceNet 
configuration tool. 
 

I/O Mapping 

The content and layout of the data in the I/O Table is defined during configuration of the 
scan list. The input and output data of each slave is configured, or mapped, to specific 
locations in the Input and Output buffers. 
 

Input Data Safe State 

The BridgeWay provides the option of configuring how the data in the Input buffer will be 
set when a DeviceNet slave connection faults. The safe state behavior may be configured 
as one of the following: 

• Maintain Last State 

• Zero Data 

• Set Values to -1 
 

If the option is set to Maintain Last State, the input data associated with a DeviceNet slave 
will be frozen to the last value received from the slave prior to the connection fault.  
 
If the option is set to Zero Data, the input data associated with the slave will be set to 0 
when the connection is faulted.  
 
If the option is set to -1, the input data associated with the slave will be set to 0xFF when 
the connection is faulted. 
 
Only the input data associated with a particular slave’s I/O mapping configuration will be 
affected, all other non-faulted slaves’ data will continue to update normally. Note that this 
is a global setting and all slave connections will be treated in the same manner. 
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Proxy for Group 2 Only Devices 

The BridgeWay provides the capabilities necessary for being a Group 2 Only Client as 
defined for the Predefined Master/Slave Connection Set. Group 3 explicit messages 
destined for a group 2 only device that is configured as a slave to the BridgeWay will be 
intercepted and relayed to the slave. 
 

Quick Connect Feature 

The BridgeWay supports DeviceNet Quick Connect. Quick Connect is a special, shortened 
connection establishment procedure. Quick Connect can be used in applications where 
the normal delay between when a slave comes online and the scanner establishes a 
connection cannot be tolerated. Quick Connect is enabled on a per-slave basis using the 
RSNetworx Tools → Quick Connect menu. 
 

Active Node List 

The BridgeWay monitors the DeviceNet network and tracks the online/offline state of all 
nodes on the network. The current state of each node is kept in the Active Node List which 
can be accessed at DeviceNet object instance attribute 13.  
 
The message bridging utilizes the Active Node List to determine whether a target node is 
online. If the target node is not online, the bridging functions will immediately return an 
error response.  
 
Note: The Active Node List feature will create some additional traffic on the DeviceNet 
network as the BridgeWay queries the network to monitor device online status.   If the 
network cannot tolerate the additional traffic it is recommended that the Active Node List 
option be disabled. 
 
The Active Node List monitoring can be disabled in the BWConfig DeviceNet network 
configuration. 
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Run/Idle Mode 

The BridgeWay has two modes of operation, Run and Idle. In both modes, the BridgeWay’s 
DeviceNet master maintains connections with slave devices in its scan list. 
 
In Run mode, the BridgeWay sends output data to the slaves and receives input data. 
Since it is actively sending output data affecting slave device operation, the BridgeWay 
rejects attempts to alter its scan list configuration and disrupt communications; it must 
first be put in Idle mode. 
 
In Idle mode, the BridgeWay still receives input data from the slaves but it does not send 
output data. In Idle mode, the BridgeWay scan list configuration can be changed. 
 
The Run/Idle mode of the BridgeWay is controlled through the command register at the 
front of the output data from the Ethernet controller. 
 
The module automatically reverts to Idle mode when the Ethernet I/O messaging stops. If 
the Ethernet protocol is EtherNet/IP, this is handled when the I/O connection closes. If the 
protocol is Modbus/TCP, this is handled when no requests are received within the 
configured timeout period. 
 
Note: When the BridgeWay is reset or powered up, it begins operation in Idle mode. 
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Automatic Device Recovery (ADR) 

ADR is a feature of the DeviceNet master which allows a slave node to be configured when 
the I/O connection is established.  This not only guarantees device configuration, but 
provides a means to replace a faulty device with a new one without any additional device 
commissioning. 
 
 There are 2 parts to ADR, Address Recovery, and Configuration Recovery. 
 

Address Recovery 

Address Recovery is responsible for automatically setting a new device’s address to that of 
a slave that has lost communications. The steps followed by ADR are: 
 

1. When the BridgeWay detects the loss of a DeviceNet slave, it begins to monitor for 
a new device at MAC ID 63. 

2. An identical device is added to the network at MAC ID 63 (default out of box 
configuration for a DeviceNet device). 

3. The BridgeWay verifies that the new device at 63 is exactly the same kind as the 
slave that was lost by querying the Identity attributes. 

4. The BridgeWay changes the new device’s MAC ID to that of the lost slave. 
 

Configuration Recovery 

Configuration Recovery is responsible for setting the configuration of a slave device to the 
configuration that is stored in the BridgeWay. The slave’s configuration is stored in the 
BridgeWay’s non-volatile memory. Whenever the BridgeWay establishes a connection 
with the slave device, the configuration is downloaded to the slave. 
 
Configuration recovery serves 2 purposes.  

1. If a new device is added to the network to replace a faulted slave, after Address 
Recovery is completed, Configuration Recovery will configure the new device.  

2. Configuration Recovery guarantees that the slave devices will always run the same 
configuration. 

 
The BridgeWay module will hold up to 130,560 bytes (approximately 128K) of 
configuration recovery data. 
 
Note: RSNetworx v7.0 or later is required to support the full 128K bytes of ADR 
configuration recovery data; earlier versions support up to 64K bytes of data. 
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Interaction with I/O Table 

The DeviceNet interface in the BridgeWay accesses the I/O Table as slave I/O connections 
are processed by the DeviceNet master; there is no buffering or timed updates of the I/O 
within the module. Safeguards are in place to ensure data integrity by prohibiting 
simultaneous access by the Ethernet and DeviceNet interfaces. There is no 
synchronization between the 2 network interfaces. 
 
When an I/O connection with a slave requires output data be sent to the slave, data will be 
read from the Output buffer. The data read is what was placed there by the last write to 
the Output buffer by the Ethernet interface.  
 
Transmission of data on Change of State (COS) connections is triggered when new output 
data is written by the Ethernet interface in the region mapped by the COS connection. 
 
When input data is received on a slave’s I/O connection, it is copied to the Input buffer. 
This data is available to be read by the Ethernet interface immediately after it has been 
written. 
 
 
 



  Message Bridging 
 

 
© Pyramid Solutions 65 PUB-BW4030-002 

Ethernet to DeviceNet Message Bridging 

Message bridging provides the ability to send a CIP request on DeviceNet the Ethernet 
network.  The message can originate from either an EtherNet/IP or Modbus TCP request.    
 

EtherNet/IP Message Bridging 

The CIP protocol provides bridging capabilities to allow messages to be routed from a 
device on EtherNet/IP to a device on DeviceNet.  The BridgeWay allows a device on 
EtherNet/IP to send an Explicit Message to a device on DeviceNet and receive the 
associated response.   This allows the device on EtherNet/IP to directly access the objects 
and attributes of any DeviceNet device to configure or access data. 
 
To send an Explicit Message to a DeviceNet device, the Unconnected Send services of the 
Connection Manager Object are used. The MAC ID of the destination DeviceNet node along 
with a network port address must be used in the Unconnected Send service. Refer to 
Volume 1, Chapter 10 of the EtherNet/IP specification for further information on CIP 
Bridging. 
 
The BridgeWay supports multi-hop bridged paths. If a routing path routes the message 
through the local DeviceNet network to another network, via another bridge, the 
BridgeWay will correctly route the message to the next bridge using an Unconnected Send 
service over DeviceNet. 
 
Note: The BridgeWay does not support message routing from DeviceNet to EtherNet/IP. 
 

Bridged Message CIP Request Address 

CIP messages that are to be sent to a DeviceNet node must be sent to Port 3.  The CIP 
request path must use the following format: 
 

 <BridgeWay_IP>,3,<DeviceNet_MAC> 
 
Where  
 <BridgeWay_IP>  The IP address of the BridgeWay 
 <DeviceNet_MAC> Destination DeviceNet address  
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Modbus TCP Message Bridging 

CIP bridging from Modbus TCP may be done by writing to a set of Holding registers 
(starting at 42201) and reading the result from a set of Input registers (starting at 32325). 
 
Note: The result may also be read at Holding registers starting at 42325. 
 
Note: The Modbus register addresses below are 1-offset.  Some Modbus controllers 
specify registers 0-offset; in that case, the register or bit addresses would be subtracted by 
1. 
 

Bridged Message Request Registers 

The bridged message fields are specified in the following Holding registers. 
 

Holding 
Register 

Register 
Count 

Description 

2201 1 Request Counter 

This register is incremented by 1 to trigger the 
transmission of the bridged request. 

As long as the Request Counter is not incremented, 
the message request registers below can be changed 
without affecting the message transmission.  Once the 
Request Counter is incremented, the message request 
registers should not be altered until the Result 
Counter (Input Register 2325) matches the Request 
Counter. 

2202 1 DeviceNet MAC address 

2203 1 CIP Service  

2204 1 CIP Class 

2205 1 CIP Instance 

2206 1 CIP Attribute 

2207 1 Request data length in bytes 

2208 Up to 
116 

Request data 

Table 22. Modbus TCP Bridged Message Request Registers  
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Bridged Message Response Registers 

The status/extended status and response data for the bridged request can be read in the 
following Input registers. 
 

Input 
Register 

Register 
Count 

Description 

2325 1 Result Counter 

This register is incremented by 1 to indicate that a 
bridged transmission has completed. 

2326 1 CIP response status 

2327 1 CIP response extended status 

2328 1 Response data length in bytes 

2329 Up to 
120 

Response data 

Table 23. Modbus TCP Bridged Message Response Registers 
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Status and Diagnostics 

BridgeWay LEDs 

There is a group of LED indicators on the front of the BridgeWay that is used to indicate 
the status of the module and the network interfaces. The layout of the LEDs is shown 
below. 

BW

NS NS

MS MS

DeviceNet Ethernet

Ethernet Network Status

Ethernet Module Status

Not Used

Not Used

DeviceNet Network Status

DeviceNet Module Status

BridgeWay Status

 
Figure 20. BridgeWay LEDs 

 

BridgeWay Status LED 

LED State Summary Description 

Flashing Green Idle Module is in Idle mode. 

Solid Green Run Module is in Run mode. 

Solid Amber Bootloader /  
Initialization 

The LED will be in this state immediately after 
power is applied. 
 
If the bootloader is running all LEDs will be 
Amber.  

Table 24. BridgeWay Status LED States 
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DeviceNet Network Status LED 

LED State Summary Description 

Flashing Green Online, No 
Communication 

The DeviceNet network interface is online but 
there are no active communications. 

Solid Green Online and 
Communicating 

The DeviceNet network interface is online and 
actively communicating with at least one 
device. 

Solid Red Interface Fault The DeviceNet network interface is bus-off or a 
duplicate MAC ID has been detected. 

Flashing Red Connection 
Timeout 

Communications with at least one DeviceNet 
slave has timed out. 

Solid Amber Bootloader  
 

If the bootloader is running all LEDs will be 
Amber.  

Table 25. DeviceNet Network Status LED States 

 

DeviceNet Module Status LED 

LED State Summary Description 

Flashing Green Initializing The DeviceNet network interface is initializing 
or is has not been configured and is using 
default values. 

Solid Green Configured The DeviceNet network interface has been 
successfully configured and is operating 
normally. 

Solid Red Initialization 
Error 

An error was detected in the configuration and 
the DeviceNet network interface initialization 
could not complete. 

Solid Amber Bootloader  
 

If the bootloader is running all LEDs will be 
Amber.  

Table 26. DeviceNet Module Status LED States  
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Ethernet Network Status LED 

LED State Summary Description 

Solid Green Connected There is at least one connection from an 
Ethernet Controller.  

Flashing Green Network OK There are no active connections.  

Solid Red Address conflict The module’s IP address is already in use by 
another module. 

Flashing Red Connection 
Timeout 

One or more of the I/O connections has timed 
out.  

Solid Amber Bootloader  
 

If the bootloader is running all LEDs will be 
Amber.  

Table 27. Ethernet Network Status LED States 

Note: When both EtherNet/IP and Modbus TCP are enabled in the Ethernet Network 
configuration, the Network Status LED will only show Connected and Timeout status for 
EtherNet/IP connections. 
 
 

Ethernet Module Status LED 

LED State Summary Description 

Flashing Green Initializing The Ethernet network interface is initializing 
and not configured. 

Solid Green Configured The Ethernet network interface has been 
successfully configured. 

Flashing Red Configuration  There is an error in the configuration. 

Solid Red Initialization 
Error 

An error was detected in the configuration and 
the Ethernet network interface initialization 
could not complete. 

Solid Amber Bootloader  
 

If the bootloader is running all LEDs will be 
Amber.  

Table 28. Ethernet Module Status LED States 
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Ethernet Network LEDs 

The Ethernet Network LEDs are located on the RJ-45 connector. 
 

SpeedLink/Activity

 
Figure 21. Ethernet Network LEDs 

 

Ethernet Link/Activity LED 

The Link/Activity LED is green if the link is up and flashes green as Ethernet packets are 
received or transmitted.   The LED is off if there is no link. 
 

Ethernet Speed LED 

The Speed LED is Amber if the link speed is 100Mbps.  The LED is off if the speed is 
10Mbps. 
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BWConfig Status View 

Status Tab 

The Status tab on the BWConfig Status view contains general status information for the 
BridgeWay and the network interfaces. 
 
The following subsections describe the status and state values that may be displayed for 
some of the Status tab fields. 
 
BridgeWay Error 

State Description 

No Error The module has successfully initialized and is running. 

Configuration Error An error in the configuration was detected. 

Initialization Error An error occurred during startup and initialization. 

Table 29. BridgeWay Error Values 

Ethernet Interface State 

State Description 

Initializing The Ethernet interface is initializing. 

Configuration Error There is an error in the configuration and the Ethernet 
interface is not able to be initialized. 

Initialization Error There is an error in the system or Ethernet network that 
caused the Ethernet interface initialization to fail. 

Address Error An IP address conflict was detected. 

Offline The Ethernet interface is configured and initialized, but no 
Ethernet link is detected. 

Online The Ethernet interface is online and participating in network 
activity. 

Table 30. Ethernet Interface States 
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Ethernet Status 

State Description 

No IP Assigned No IP address has been assigned. 
This typically the state while waiting for a DHCP address 
assignment.  The IP Address State will display “Waiting for 
DHCP”.  

Not Connected The module is online, but no Ethernet controller has made 
any I/O connection. 

Connected 1 or more I/O connections are active. 

Connection Timeout 1 or more I/O connections have timed out. 

IP Address Conflict An IP address conflict was detected. 

Table 31. Ethernet Status Values 

DeviceNet Interface State 

State Description 

Initializing The DeviceNet interface is initializing. 

Configuration Error There is an error in the configuration and the DeviceNet 
interface is not able to be initialized. 

Initialization Error There is an error in the system or DeviceNet network that 
caused the DeviceNet interface initialization to fail. 

Address Error A duplication MAC ID was detected. 

Offline The DeviceNet interface is configured and initialized, but is 
unable to communicate on the CAN network. 

Online The interface is online and participating in DeviceNet 
network activity. 

Table 32. DeviceNet Interface States 
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DeviceNet Status 

Status Description 

Configured The DeviceNet network interface is configured and initialized 
and is attempting to go online for the first time. 

Online The DeviceNet network interface is online and participating 
in network activity. 

Autobaud in 
Progress 

The interface is performing automatic baud rate detection 
prior to coming online. 

Duplicate MAC 
Check in Progress 

The interface is checking for duplicate MAC IDs on the 
network prior to coming online. 

Duplicate MAC 
Error 

A duplicate MAC ID was detected on the network.  The 
module will remain offline. 

Network Disabled The DeviceNet network interface is disabled. 

No Network Power No CAN network power is present for the DeviceNet 
network. 

Bus-Off The DeviceNet network interface has been knocked offline 
due to CAN network errors. 

Autoscan in 
Progress 

The DeviceNet master is scanning the network and 
automatically generating a scan list configuration. 

Table 33. DeviceNet Status Values 

 
 

Diagnostic Counters Tab 

The Diagnostic Counters tab on the BWConfig Status view displays counters and status 
information that are specific to each of the network interfaces.   
 

Slave Status Tab 

The Slave Status tab on the BWConfig Status view displays the status of the configured I/O 
connections with the DeviceNet slaves.  The display shows the status next to the MAC ID 
of the slave.  Unconfigured slaves will have a blank status.   Configured slaves’ status will 
be one of the node status values shown in the DeviceNet Node Status Values 
section.   
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BridgeWay Web Pages 

The web pages on the BridgeWay are accessible using any web browser by entering the IP 
address of the BridgeWay as the URL.    
 

Web Status Tabs 

The web page contains 3 status tabs, for BridgeWay, Ethernet and DeviceNet, each 
displaying status and state information for the associated module or network interface.  
The information displayed on the web page status tabs mirror that displayed on the 
BWConfig Status view described above. 
 

Web I/O Table Tabs 

The web page contains an Input Table and Output Table tab.  These tabs display the 
current data in the Input and Output buffers of the BridgeWay. 
 
The displayed word size, starting offset and byte count can be set at the top of the tab, as 
well as the display radix, allowing the data display to be configured to meet the user’s 
needs. 
 

Status Data  

The status data contains status and diagnostic information for the DeviceNet network 
interface.  The status data is accessible through the EtherNet/IP Status Assembly (see 
Status Assembly) or the Modbus Status Data registers (see Status Data).  See the 
referenced sections for complete details. 
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DeviceNet Node Status Values 

Node status values are used in many places in DeviceNet network interface status data to 
indicate the status of the BridgeWay and the slave devices.  The table below describes the 
possible status values. 
 

Status Value Description 

0 Ok. 
 
Note that this value will be used for nodes both in and out of the 
scan list to indicate that there is no issue with the node. 

60 Duplicate MAC ID test in progress. 
 
This status is only used for the BridgeWay MAC ID. 

70 Duplicate MAC ID failure. 
 
Another node on the DeviceNet network has the same MAC ID. 
 
This status is only used for the BridgeWay MAC ID. 

72 Device communications failed. 
 
The I/O connection with the slave has timed out. 

73 Incorrect device type. 
 
Device verification has failed with a slave when attempting to start 
I/O connections. The level of verification is determined by the scan 
list entry. The following identity information may be checked during 
verification depending on the configuration: 

Vendor ID  
Revision  
Device Type  
Product Code 

75 CAN network quiet. 
 
No CAN packets have been received from the network for more 
than 10 seconds. 
 
This status is only used for the BridgeWay MAC ID. 
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Status Value Description 

76 No messages for BridgeWay. 
 
No CAN packets specifically for the BridgeWay DeviceNet interface 
have been received in more than 10 seconds. 
 
This status is only used for the BridgeWay MAC ID. 

77 Incorrect connection size. 
 
The connection size configured in the scan list entry for the slave 
does not match the actual required connection size specified by the 
slave. 

78 No device response. 
 
A connection could not be established with the slave because it did 
not respond. 

79 CAN DUP-MAC transmit failure. 
 
The DeviceNet interface was unable to transmit the duplicate MAC 
detection message on the CAN network. 
 
This status is only used for the BridgeWay MAC ID. 

80 In Idle mode. 
 
The device is in Idle mode. 
 
This status is only used for the BridgeWay MAC ID. 

81 Faulted. 
 
The DeviceNet network interface is faulted, and all DeviceNet 
network activity is disabled. 
 
This status is only used for the BridgeWay MAC ID. 
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Status Value Description 

83 Error during slave connection initialization. 
 
An error occurred while creating the I/O connections to the slave 
(beyond the identity mismatch or I/O size errors). This error is 
triggered by error responses from the slave during the connection 
establishment sequence. 

84 Slave connection initialization in progress. 
 
The I/O connection establishment sequence to this slave is in 
progress. 

85 Incorrect data size received on connection. 
 
The amount of data received with the last connected message does 
not match the connection size. 

86 Device went into Idle mode. 
 
The slave is in Idle mode as indicated by the slave sending idle 
packets on the input connection. Idle packets are of zero length and 
are used to keep the connection open, yet not move any data when 
the device is in Idle mode. 

87 Shared master error. 
 
The slave scan list entry is configured for input sharing and the 
primary master has not made a connection to the device. 

88 Shared master choice error. 
 
The slave scan list entry is configured for input sharing and the 
primary master has not made the right type of connections to the 
device. 

89 ADR error. 
 
An error occurred during auto device replacement or con- 
figuration recovery. This is triggered when the slave returns an 
error response during an auto device replacement or configuration 
recovery message sequence. 
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Status Value Description 

90 Network disabled. 
 
The DeviceNet network interface has been disabled. 
 
This status is only used for the BridgeWay MAC ID. 

91 CAN bus-off. 
 
Indicates that the DeviceNet CAN controller is in the Bus-Off state.  
 
This status is only used for the BridgeWay MAC ID. 

92 No DeviceNet power. 
 
Indicates that there is no network power detected on the 
DeviceNet network. 
 
This status is only used for the BridgeWay MAC ID. 

Table 34. DeviceNet Node Status Values 
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Specifications 

General 

Weight  184g  
Dimensions (L x W x H)  110 x 35 x 101 mm 

4.33 x 1.38 x 3.98 inches 
Protection class  IP20, NEMA rating 1  
Mounting  DIN rail (35 x 7.5/15) or Wall Mount  

Certifications 

UL  UL 61010-1  
UL 61010-2-201  

Hazardous Locations  ANSI/ISA 12.12.01  
ATEX  EN 60079-0  

EN 60079-15  
CE  EN 61000-6-2  

EN 61000-6-4  

Electrical 

Power  7 – 40 VDC  
Current consumption  300mA at 24 VDC  

Environmental 

Operating temp (Ta) IEC 60068-2-1  
IEC 60068-2-2  

-25 to 70 oC  

Storage temp  IEC 60068-2-1  
IEC 60068-2-2  

-40 to 85 oC  

Relative Humidity  IEC 60068-2-30  5-95 % non condensing  
Installation altitude  Up to 2000 m  

Emission and Immunity 

Electrostatic discharge  EN 61000-4-2  +/- 4 kV  Contact, +/- 8kV Air 
Electromagnetic RF fields  EN 61000-4-3  10 V/m 80 MHz - 1 GHz  

3 V/m 1.4 GHz – 2 GHz  
1 V/m 2 GHz – 2.7 GHz  

Fast Transients  EN 61000-4-4  +/- 2kV AC, +/- 1 kV IO 
Surge protection  EN 61000-4-5  +/- 1 kV Diff, +/- 2kV Comm 
RF conducted interference  EN 61000-4-6  10 V/rms  
Emissions (Radiated) 
Emissions (Conducted)  

EN 55011 
EN55011  

30 MHz - 100 MHz, Class A 
150 kHz - 39 MHz, Class A 
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Certifications 
 

Atex Certification 
 

 e II 3 G  Ex nA IIC T4 Gc 

 

II 3 G 

Demko 17 ATEX 1953X 

 

Side Label 

 
Example of side label 
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I/O Table Configuration Sizes and Limits 

Input 

 4 – 500 bytes  
 

Output 

 4 – 496 bytes  
 

Status 

 128 bytes 
 

DeviceNet ADR Configuration Storage 

 130,560 bytes  
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Connectors 

Power 

 
Figure 22. Power Connector 

Use Phoenix connector part number MSTB 2,5/3-ST-5,08 
 

DeviceNet 

 
Figure 23. DeviceNet Connector 

 
Use Phoenix connector part number MSTB 2,5/5-ST-5,08 
 

Ethernet 

The BridgeWay uses a standard Ethernet RJ-45 connector. 
 

USB 

The BridgeWay uses a standard USB Micro-B connector. 
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Support 

Technical Product Assistance 

If you require BridgeWay product technical support by phone:  

• Call 248-549-1200 

• Dial 0 for the Operator 

• Ask for BridgeWay Support 
 

If you require support by email:  

• Email: productsupport@pyramidsolutions.com  

• Subject: “BW4030 Support Request” 

• Provide a detailed explanation of your question or issue in the email text. 
 
You can also obtain BW4030 files and information online at the following URL: 
http://pyramidsolutions.com/support/network-connectivity-support/ 

 

Contact Information 

Pyramid Solutions, Inc.  
302000 Telegraph Road 
Suite 440 
Bingham Farms, Michigan 48025 
 
 
Phone: 1-248-549-1200  
Toll free: 1-888-PYRASOL  
Fax: 1-248-549-1400 
Website: www.pyramidsolutions.com 

 

mailto:productsupport@pyramidsolutions.com
http://pyramidsolutions.com/support/network-connectivity-support/
http://www.pyramidsolutions.com/

